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Introduction 

 

PCIC
3
B3 2007 includes a wealth of additional information presented in the Frequently Asked 

Questions (FAQs) section of each lesson.  PCIC
3
B3 2007 FAQs relate specifically to the content 

of the lesson and provide students with an additional source of information related to the topics 

being covered. The PCIC
3
B3 2007 Guide - FAQs includes full text of the FAQs included in each 

lesson. 

 

Please Note:  FAQs are not used to meet IC
3
 Exam Objectives. 
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Unit 1 
 

B Introduction 

 

Question 1:  What knowledge and skills do I need to have before starting PCIC
3
B3? 

Answer:  If you haven't completed PCIC
3
A-Computing Fundamentals, you need to have the 

skills to work with basic computer program components, such as the operating 

system, buttons and icons, windows, menus, and dialog boxes. In addition, you 

need to have the basic skills to work with a computer's filing system. For 

example, you should be able to create, save, open, print, move, copy, rename, and 

delete files. 

 

B1 Unit 1 

 

Question 1:  How is Unit 1 structured? 

Answer:  Unit 1 contains: 

 

 29 lessons accompanied by Frequently Asked Questions 

 24 exercises 

 3 quizzes 

 

Question 2:  How long does it take to complete Unit 1? 

Answer:  Unit 1 takes approximately 7 hours and 45 minutes to complete: 

 

Lessons:   3 hours 

Questions & Answers: 1 hour 

Exercises:   2 hours and 45 minutes 

Quizzes:    1 hour 

Total:    7 hours and 45 minutes 

 

 B1.1 Presentation Program Overview 

 

Question 1:  Are there any other ways to deliver a presentation besides using a computer 

monitor or projector? 

Answer:  Yes. You can also use a slide projector or an overhead projector to deliver a 

presentation. In addition, you can also load your presentation on a Web server so 

it can be viewed on the Internet. 

 

B1.2 Getting Started 

 

Question 1:  Is Microsoft PowerPoint included on every computer as part of Windows?  

Answer:  No. PowerPoint can be obtained and installed separately, or as part of the 

Microsoft Office application suite. 
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Question 2:  Can I hide the Slide list pane containing the Outline and Slides tabs? 

Answer:  Yes. You can hide the pane in two ways: 

 

1)  Click the "Close" button on the upper-right corner of the pane, or 

2)  Drag the divider on the right of the pane all the way to the left. 

 

To display the pane again, do one of the following: 

 

1)  Click on the "Normal" button in the "View" tab, or 

2)  Drag the divider on the left of the "Slide" pane back to the desired location. 

 

B1.3 Ribbon 

 

Question 1:  Can I rearrange, add or remove any of the functions or groups on the Ribbon? 

Answer:  No, you can not customize the Ribbon by changing any of its tabs, but you can 

minimize or move the ribbon as explained in the lesson. 

 

Question 2:  In some of the tabs on the Ribbon, all the functions in a group are not shown. 

Why? 

Answer:  If the PowerPoint window is not displayed in full size, some of the groups of a tab 

will be displayed as a single button, not showing the functions they contain. If you 

click on a group's button, its functions will be displayed under it. 

 

B1.4 Entering Text in a Slide 

 

Question 1:  Why does a wavy red underline appear under some of the words that I type? 

Answer:  PowerPoint has a "Spelling" function that is turned on by default. This function 

marks the words that it considers spelling errors with a red wavy underline. If you 

correct the word that contains a spelling error, it will not be marked any more. 

The "Spelling" function is discussed in Unit 2. 

 

Question 2:  Why is the first character that I type on a new line automatically capitalized? 

Answer:  PowerPoint has an "AutoCorrect" function that is turned on by default. This 

function tries to correct the minor errors you make while typing. When you type 

in the first character on a new line, the "AutoCorrect" function assumes that you 

want to start a sentence, and therefore capitalizes the character. If you don't want 

the character to be capitalized, simply delete it and type it in lower case again. 

The character will not be capitalized any more.  

 

Question 3:  How can I prevent the text in a placeholder from being resized as I type?  

Answer:  When the text that you type is resized to fit in the placeholder, the "AutoFit 

Options" button will appear to the left of the resized text. Click on this button, and 

select "Stop Fitting Text to This Placeholder." 
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B1.6 Adding New Slides 

 

Question 1:  Is there another way to add a new slide besides the method described in the 

lesson? 

Answer:  Yes. In the slide list, click where you want the new slide to appear and then press 

the "Enter" key. 

 

B1.8 Moving Between Slides 

 

Question 1:  How can I quickly move to a specific slide in the presentation? 

Answer:  You can move to a specific slide by pressing certain keys on the keyboard as 

follows: 

 

KEY   SLIDE 

Home   First slide 

End   Last slide 

Page Up  Previous slide 

Page Down  Next slide 

Control-Home  First slide 

Control-End  Last slide 

 

B1.10 Editing a Slide's Text 

 

Question 1:  Are there any quick ways to select a part of the text other than dragging the mouse 

pointer over it? 

Answer:  Yes. You can quickly select different parts of the text as follows: 

 

Selecting a word: 

You can select a word by quickly double-clicking on it.  

 

Selecting a sentence: 

You can select a sentence by holding down the Control key, and then clicking 

anywhere in the sentence. 

 

Selecting a paragraph: 

You can select a paragraph by quickly clicking three times anywhere on it.  

 

Selecting any part of the text: 

To select any part of the text place the insertion point at the beginning of the text, 

then hold down the Shift key and place the insertion point at the end of the text. 
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Question 2:  Are there any keyboard shortcuts for the Cut, Copy, and Paste functions? 

Answer:  Yes. The keyboard shortcuts for the Cut, Copy, and Paste functions are: 

 

Key   Function 

Control-X  Cut 

Control-C  Copy 

Control-V  Paste 

 

Question 3:  How can I use the "Paste Options" button to change the appearance of the items 

that I paste? 

Answer:  After you paste an item, the "Paste Options" button will automatically appear next 

to the item. If you click on this button, a list of options will appear to let you 

change the item’s appearance. These options vary based on the type and format of 

the item. If the item is regular text, the following options will appear: 

 

- Keep Source Formatting: Keeps the text’s original formatting. 

 

- Use Destination Theme: Applies the formatting included in the current design 

template to the pasted text. The design template specifies the default styles used in 

a presentation, including the type and size of fonts and bullets, placeholder sizes 

and positions, and background design and color schemes. 

 

B1.12 Saving a Presentation 

 

Question 1:   If PowerPoint crashes or the power is lost while I am working on a presentation, 

can I recover my unsaved changes? 

Answer:  PowerPoint has an "AutoRecover" function that automatically saves your 

presentation in a recovery file, at regular intervals. The next time you start 

PowerPoint after a crash or power failure, it will automatically open the recovery 

file. The file will contain the changes you made to your presentation up until the 

last time the recovery file was saved. If you save the recovery file, it will replace 

the original presentation. If you don't save it, the file will be deleted and your 

unsaved changes will be lost. 

 

The default "AutoRecover" interval is 10 minutes, meaning every 10 minutes your 

presentation is saved in the recovery file. Therefore, you can lose only up to 10 

minutes of work. You can decrease the interval to have the recovery file saved 

more frequently, reducing the amount of work that can potentially be lost. You 

can set the interval as follows: 

 

1) Click on the "Office" button and then click on the "PowerPoint Options" 

button. 

 

2) Click on the "Save" to move its panel to the front. 
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3) Make sure the "Save AutoRecover info every:" check box is checked, then 

enter the desired interval in the text box to its right. You can any interval between 

1 and 120 minutes. 

 

Please note that the "AutoRecover" function is for emergency use only. You will 

still need to manually save your presentations. 

 

Question 2:  I opened and modified a presentation, but when I tried to save it, a dialog box 

appeared with a message indicating the presentation is read-only. What does this 

mean, and how can I save the presentation? 

Answer:  It means the property of the file containing the presentation has been set to read-

only to prevent it from being changed. Therefore, you cannot save the 

presentation in its existing file. However, you can save it as a new file. Simply, 

click on "OK" in the dialog box containing the error message. The "Save As" 

dialog box will automatically appear to let you save the presentation in a new file. 

 

Question 3:   Can I save a presentation I created in PowerPoint as a Rich Text Format file? 

Answer:   Yes. However, when you save a presentation as a Rich Text Format (RTF), only 

the presentation's text will be saved. All the other elements contained in the 

presentation, including its graphics will be lost. To save your presentation as a 

RTF file, select "Outline/RTF" from the "Save as type" drop-down list in the 

"Save As" dialog box. 

  

Question 4:  Can I change the default folder for saving my presentation files? 

Answer:  Yes. You can change the default folder from the "Documents" folder to the 

desired folder as follows: 

 

1) Click on the "Office" button and then click on the "PowerPoint Options" 

button. 

2) Click on the "Save" to move its panel to the front. 

3) In the "Default file location" text box, type the desired location and click on 

OK. The default working folder for saving your files will change to the one you 

specified. 

 

B1.15 Creating a New Presentation 

 

Question 1:  When do the new blank presentations that I create contain only one slide? 

Answer:  PowerPoint only creates the first slide in a new blank presentation. You can add 

more slides to the presentation as described before in the "Adding New Slides" 

lesson. 
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B1.17 Opening a Presentation 

 

Question 1:   The file that I want to open in PowerPoint does not appear in the Open dialog 

box. I am sure the file is in the Look-in location that I have selected. What is 

going on? 

Answer:  The file is not a PowerPoint presentation. To make the file appear in the dialog 

box, you need to select its type from the "Files of type" drop-down list. For 

example, if you are trying to open a Web presentation, you must select "Web 

pages (*.htm; *.html)" from the list. You can also select "All Files" to display all 

the files residing in the Look-in location. 

 

Question 2:  Can PowerPoint help me find the presentation that I am trying to open? 

Answer:  Yes. You can get help in finding a file by entering the file's name in the "Search" 

text box at the upper right of the "Open" dialog box. PowerPoint will search 

among the files in the current location and displays only the files that match what 

you typed. 

 

B1.19 Viewing a Presentation 

 

Question 1:  Can I change PowerPoint's default view? 

Answer:  Yes. You can change the default view, for example a view with no slide list or 

notes. To set a different default view, follow these steps: 

 

1) Click on the "Office" button and then click on the "PowerPoint Options" 

button. 

2) Click on "Advanced" to bring its panel to the front. 

3) Under the "Display" category, open the drop down list labeled "Open all 

documents using this view" and select the desired option from the list. 

 

B1.21 Organizing Slides 

 

Question 1:  Why would I need to copy a slide since I don't want the same slide to appear twice 

in my presentation? 

Answer:  The reason you would copy a slide is to keep the text style and slide layout of the 

original slide. You can then change the text of the copied style as desired while 

keeping the original slide's style and format characteristics. 
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B1.24 Slide Backgrounds 

 

Question 1:  How can I change default colors that appear in the background color list?  

Answer:  The set of colors that appear in the background color list is referred to as the color 

scheme. The color scheme consists of the eight matching colors used in the design 

of the slide elements such as background, text and lines. 

 

You can choose a different color scheme as follows: 

 

1) Click on the "Design" tab. 

2) Click on the "Colors" button in the "Themes" group. 

3) Select the desired color scheme from the list. 

 

Question 2:  How can I remove the background from a slide?  

Answer:  You can remove the background from a slide as follows: 

 

1) Select the slide. 

2) Click on the "Design" tab. 

3) Click on the "Background Styles" button in the "Background" group. 

4) Select "Reset Slide Background" from the gallery. 

 

B1.26 Fonts 

 

Question 1:  Can I apply any special effects to a slide's text? 

Answer:  Yes. You can apply various special effects to the text by first selecting it. Then 

click on the dialog box launcher in the "Font" group of the "Home" tab to open 

the "Font" dialog box will open. You can select the check boxes in the dialog box 

to apply the following effects: 

 

- Underline 

- Shadow 

- Emboss 

- Superscript 

- Subscript 

 

Question 2:  Can I remove all the formatting of the slide's text at once? 

Answer:  Yes. You can easily remove all the formatting of the text at once by first selecting 

it. Then click on the "Clear All Formatting" button in the "Font" group of the 

"Home" tab. 
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B1.28 Alignment 

 

Question 1:  Can the lines in a paragraph have different alignments? 

Answer:  No. A paragraph's alignment applies to all of its lines. If you want to align each 

line in a paragraph individually, you need to break the paragraph into separate 

lines. 

 

B1.30 Bullets & Numbering 

 

Question 1:  How can I remove bullets and numbering from the text? 

Answer:   First, select the bulleted or numbered text. Then, if the text is bulleted, click on 

the "Bullets" button, or if the text is numbered, click on the "Numbering" button. 

The bullets or numbers will be removed from the text. 

 

Question 2:  If I delete an item in the middle of a numbered list, do I have to renumber the list 

to adjust the sequence of numbers? 

Answer:  No. PowerPoint will automatically adjust the numbering for you. 

 

Question 3:  Can I delete a single bullet from the bulleted list? 

Answer:  Yes. To delete a single bullet, place the insertion point to the right of the bullet 

and press the Backspace key, or click on the "Bullets" button. 

 

B1.32 Format Painter 

 

Question 1:  Can I use the Format Painter to apply all the formatting contained in a slide to 

another at once? 

Answer:  Yes. Follow the steps below: 

 

1) In the slide list, select the slide with the desired formatting. 

2) Click on the Format Painter button. 

3) In the slide list, select the slide to which you want to apply the formatting. 

 

B1.34 Mini Toolbar 

 

Question 1:  How can I prevent the Mini Toolbar from appearing when I select text? 

Answer:  To disable the Mini Toolbar, follow these steps: 

 

1) Click on the Office button. 

2) Click on the "PowerPoint Options" button. The "PowerPoint Options" dialog 

box will appear. 

3) Make sure that the "Popular" option is selected in the left column of the 

"PowerPoint Options" dialog box. 

4) Deselect the "Show Mini Toolbar on selection" check box. 

5) Click on the "OK" button. 
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Question 2:  Can I add or remove any of the functions to the Mini Toolbar? 

Answer:  No. PowerPoint does not allow you to customize the Mini Toolbar. 

 

B1.36 Live Preview 

 

Question 1:  Can I disable Live Preview? 

Answer:  Yes. You can disable Live Preview by following these steps:  

 

1) Click on the "Office" button. 

2) Click on the "PowerPoint Options" button. The "PowerPoint Options" dialog 

box will appear. 

3) Make sure that the "Popular" option is selected in the left column of the 

"PowerPoint Options" dialog box. 

4) Deselect the "Enable Live Preview" check box. 

5) Click on the "OK" button. 

 

B1.38 Displaying a Slide Show 

 

Question 1:  How can I prevent a specific slide from appearing in a slide show?  

Answer:  You can prevent a slide from appearing in a slide show by hiding the slide. To 

hide a slide, simply select it in the slide list, and then select "Hide Slide" button in 

the "Set Up" group of the "Slide Show" tab. 

 

Question 2:  Can I use the keyboard to navigate through the slide show?  

Answer:  Yes. The keys that you need to use and their corresponding functions are listed 

below: 

 

KEY  FUNCTION 

Spacebar Displays the next slide. 

 

Backspace Displays the previous slide. 

 

Enter Displays the next slide. You can also type the number of the 

desired slide and then press the Enter key to go to a specified slide. 

 

Esc  Ends the slide show. 

 

B Pauses the slide show and changes the screen to all black. Press 

this key again to return to the slide show. 

 

W Pauses the slide show and changes the screen to all white. Press 

this key again to return to the slide show. 
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Question 3:  Can I remove the pen marks on a slide?  

Answer:  Yes. You can remove the marks as follows: 

 

1) Click on the "Pen" button. 

2) Select "Eraser" from the menu that appears. 

3) With the eraser tool, click on the mark you want to remove. To remove all the 

marks at once, simply press the "E" key on the keyboard. 

 

B1.40 Saving a Slide Show 

 

Question 1:  Can I display my slide show on a computer that does not have PowerPoint?  

Answer:  Yes. You can use the "Package for CD" function to save the slide show together 

with "PowerPoint Viewer" so the slide show can be displayed on a computer that 

does not have PowerPoint installed on it. To use this function, first click on the 

"Office" button, then move the mouse pointer over "Publish" and select "Package 

for CD." A dialog box will open to let you save the presentation as desired. 

 

B1.42 Adding Notes 

 

Question 1:  Can I change the formatting of the Notes page in a slide? 

Answer:  Yes. Open the "View" tab and click on "Notes Master" in the "Presentation 

Views" group. Then make the desired changes to the "Notes Master." The changes 

will be applied to all the Notes pages of all the slides. 

 

B1.44 Print Setup 

 

Question1:  Can I print large posters from PowerPoint? 

Answer:  Yes. PowerPoint allows you to print a maximum page size of 56 x 56 inches. 

However, your printer must also support large paper sizes. 

 

B1.46 Print Preview 

 

Question 1:  If I change the view size in the "Print Preview" mode, will the view size also 

change when I go back to the normal view. 

Answer:  No. Changing the view size in the "Print Preview" mode does not affect the view 

size in the "Normal" view. 

 

B1.48 Printing 

 

Question 1:  Why does the "Print" function in the "Office" menu appear dimmed? 

Answer:  The "Print" function is not available. This may be due the following: 

 

a) The printer is not turned on. 

b) The printer is not properly connected to your computer. 

c) The printer may not be selected. Select the printer from the "Print" dialog box. 



 

Teknimedia Corporation  PCIC
3
B3 2007 

 
 

12 

d) The printer driver may not have been installed properly. Install the printer 

driver according to the instructions that came with your printer.  

 

Question 2:  What is the function of the "collate" check box in the "Print" dialog box?  

Answer:  The "collate" check box specifies the order in which a presentation's pages will be 

printed when you are printing multiple copies of multiple pages.  

 

For example, when you are printing 2 copies of the 3 page presentation: 

 

If "collate" is checked, the pages will be printed in the following order: 

 

page 1, page 2, page 3, page 1, page 2, page 3. 

 

If "collate" is unchecked, the pages will be printed in the following order: 

 

page 1, page 1, page 2, page 2, page 3, page 3. 

 

By default, the "collate" check box is checked. 

 

Question 3:  I created the slides in color, but when I print them they print in black and white. 

What happened?  

Answer:  If you have a color printer, the "Color/grayscale" option in the "Print" dialog box 

may have been set to "Grayscale" or "Pure Black and White." Change the 

selection to color.  

 

B1.50 Office Clipboard 

 

Question 1:  How many items does the clipboard store? 

Answer:  The clipboard stores up to the last 24 items that were cut or copied.      

 

B1.52 Getting Help 

 

Question 1:  How can I get help about a specific dialog box? 

Answer:  If there is a help topic available for the dialog box, a question mark will be 

displayed on the right of its title bar. Simply click on the question mark to view 

the help information available for the dialog box. 

 

B1.55 Unit 1 End  

Question 1:  Can I review the sections I've already visited? 

Answer:  Yes. You can either use the "Previous" section button or the "Table of Contents" 

to go to the desired section. 
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Unit 2 
 

B2 Unit 2 

  

Question 1:  How is Unit 2 structured? 

Answer:  Unit 2 contains: 

 

 21 lessons accompanied by Frequently Asked Questions 

 1 reading supplement 

 21 exercises 

 3 quizzes 

 

Question 2:  How long does it take to complete Unit 2? 

Answer:  Unit 2 takes approximately 7 hours and 45 minutes to complete: 

 

Lessons    2 hours 

Questions & Answers:  1 hour and 45 minutes 

Reading Supplement   15  minutes 

Exercises:    3 hours 

Quizzes:     1 hour 

Total:     7 hours and 45 minutes 

 

B2.1 Adding Text Boxes 

 

Question 1:  Does the text in a text box appear n the presentation's outline displayed in the 

Outline list? 

Answer:  No. If you want the text to appear in the outline, you have to enter it in a 

placeholder. 

 

Question 2:  How can I remove a textbox? 

Answer:  To remove a textbox, simply click on its border to select it, and then press the 

"Delete" key. 

 

B2.3 Formatting Placeholders & Text Boxes 

 

Question 1:  The border that I added around the placeholder does not appear. Why? 

Answer:  The border may have the same color as the placeholder's background. Check the 

border color and change it if necessary. 
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B2.5 Tabs 

 

Question 1:   What other tabs are available besides the "Left" tab? 

Answer:  The following tabs are available: 

 

Tab  Marker  Alignment   

Left  |    Aligns the beginning of the 

      text under the tab stop. 

 

Center  |     Centers the text under the tab stop 

 

Right  |    Aligns the end of the text 

       under the tab stop. 

 

Decimal |.   Aligns the decimal point 

      contained in the text at the  

      tab stop. This tab is used to 

      line up numbers containing  

      decimal points. If the text  

      does not contain a decimal 

      point, the end of the text will 

      be lined up under the tab stop. 

 

Bar  |  Inserts a vertical line at the tab 

      stop. 

 

You can set a tab stop for one of the above tabs by first selecting the desired tab 

stop in the "Tab" box to the left of the ruler. By default, this box contains the 

marker of a "Left" tab stop. You must click on the "Tab" box until the marker of 

the desired tab stop appears in it. Then, simply click on the ruler at the desired 

location to set a tab stop. Once you have set the tab stop, you can insert tabs 

before the desired text to line it up under the tab stop. 

 

Question 2:  How can I remove a tab stop that I've set? 

Answer:   To remove a tab stop, simply drag it outside the ruler and release the mouse 

button. The tab stop will disappear. 

 

Question 3:   Can I use spaces instead of tabs to line up columns of text? 

Answer:   This is not a good idea. When you use spaces instead of tabs to line up a column 

of text, the column’s line up will be lost if you change the font size of the text. In 

addition, the text may appear lined up correctly on the computer screen, but it may 

not be lined up accurately when you print the document. 
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B2.7 Header & Footer 

 

Question 1:  How can I remove the header and footer from my slides?  

Answer:  To remove the header and footer from the slides, follow these steps: 

 

1) Select "Header and Footer" from the "Insert" tab. The "Header and Footer" 

dialog box will open. 

2) In the "Slide" panel, clear all the check boxes. 

3) Click on the "Apply to All" button. The header and footer information will be 

removed from the slides. 

 

To remove the header and footer from a specific slide, first select it. Then follow 

steps 1 and 2 above. In step 3, click on the "Apply" button instead of the "Apply 

to All" button. 

 

B2.9 Spelling Check 

 

Question 1:  After I use the "Spelling" function to correct my presentation's spelling errors, can 

I be sure the presentation is completely error free?  

Answer:  No. The presentation may contain errors that may not be caught by the "Spelling" 

function. For example, if the word "from" has been incorrectly typed as "form" in 

the presentation, it will not be found as an error. Therefore, you may want do a 

final review of your presentation, after running the "Spelling" check. 

 

Question 2:  How can I prevent the spelling errors from being underlined in the presentation? 

Answer:  You need to set PowerPoint's "Spelling" options as follows: 

 

1)  Click on the "Office" button and then click on the "PowerPoint Options" 

button. The "PowerPoint Options" dialog box will open. 

  

2)  Click on the "Proofing" button to move its panel to the front.   

 

3)  Click on the "Check spelling as you type" check box to deselect it.  

  

4)  Click on the "OK" button. 

 

Question 3:  Why does PowerPoint mark a correctly spelled word as an error? 

Answer:  PowerPoint has a dictionary that it uses to check your presentation's spelling. It 

compares the words in the presentation with the words in its dictionary. It marks 

any word in the presentation that doesn't exist in the dictionary as an error, even 

when the word is spelled correctly. For example, a last name such as "Becker" 

will be marked as an error, although it is spelled correctly. 

 

You can add the word to the dictionary to prevent it from being found as an error. 

To add a word to the dictionary, first find it using the "Spelling" function, and 
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then click on the "Add" button in the "Spelling" dialog box. The word will be 

added to the dictionary, and will not be found as an error any more. 

 

Question 4:  Does the "Spelling" function check every word in the presentation? 

Answer:  By default, the "Spelling" function checks every word in the presentation except 

those that are in all uppercase, or contain a number. To have the "Spelling" 

function check those words as well, set its options as follows: 

 

1)  Click on the "Office" button and then click on the "PowerPoint Options" 

button. The "PowerPoint Options" dialog box will open. 

  

2)  Click on the "Proofing" button to move its panel to the front.   

 

3) Click on the "Spelling & Style" tab to move its panel to the front. 

 

4) Deselect the "Ignore words in UPPERCASE" and "Ignore words with 

numbers" check boxes. 

 

5) Click on the "OK" button. 

  

B2.11 Find & Replace 

 

Question 1:  What is the function of the "Match Case" and the "Find whole words only" 

buttons in the "Find" and "Replace" dialog box? 

Answer:  You can check the "Match Case" check box to only find text that has the same 

character case as the text you entered in the "Find" box. If you check the "Find 

whole words only" check box PowerPoint won't find the word if it’s part of a 

larger word; it only finds and replaces the whole words as the text you entered in 

the "Find" box. 

 

Question 2:  I'm trying to locate a word that I know exists in the presentation, but the "Find" 

function can't find it. Why? 

Answer:  One of the following may be the cause: 

 

1) You may have typed in the word incorrectly in the "Find What" box. Make sure 

that word is entered correctly in the "Find What" box. 

  

2) The word may be misspelled in the presentation. Check the presentation's 

spelling as described in the "Spell Check" lesson. 

 

3) A specific search option, for example "Match Case" may be set. The options set 

appear underneath the "Find What" box. If an undesired option is set, turn the 

option off.  
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B2.14 Inserting Clip Art & Pictures 

 

Question 1:  How can I add a clip art to the existing collection? 

Answer:  To add a clip art to your collection, follow these steps: 

 

1.  Click on "Organize Clips" at the bottom of the "Insert Clip Art" task pane. The 

"Microsoft Clip Organizer" dialog box will appear. 

2.  In the "File" menu, select "Add Clips to Organizer", and then select "On My 

Own."  The "Add Clips to Organizer" dialog box will appear. 

3.  Locate the clip that you want to add, select it, and then click on the "Add to" 

button. The "Import to Collection" dialog box will appear. 

4.  Select the folder where you want to place the clip, or create a new folder by 

clicking on the "New" button. Click on the "OK" button, and then on the "Add" 

button to add the clip art to the folder. 

5.  Close the "Microsoft Clip Organizer" dialog box. 

 

Question 2:  How can I download a clip art from the Internet? 

Answer:  To download a clip art from the Internet, follow these steps: 

 

1.  Click on "Clipart on Office Online" at the bottom of the "Insert Clip Art" task 

pane. The computer's browser program will start and take you to a special page 

for downloading clip art on Microsoft's web site. 

2.  Follow the directions provided on the page to view and download clips. 

 

Once you have downloaded the desired clips, the "Clip Organizer" dialog box will 

appear, displaying the downloaded clips. These clips will be stored in the 

"Downloaded Clips" folder. 

 

B2.17 Modifying Clip Art & Pictures 

 

Question 1:  How can I restore a clip art to its original size after I have resized it? 

Answer:  Follow these steps to restore a clip art to its original size: 

1.  Select the clip art. 

2.  Click on the "Size" dialog box launcher in the "Format" tab. The "Size and 

Position" dialog box will appear. 

3.  Click on the "Reset" button in the "Size" panel. 

4.  Close the dialog box. 

 

Question 2:  How can I reduce the file size of a picture that I have inserted in my presentation? 

Answer:  You can reduce the file size of your pictures as follows: 

 

1. Select the desired picture. 

2. Click on the "Compress Pictures" button in the "Adjust" group of the "Format" 

tab. The Compress Picture" dialog box will appear. 

3. Select the desired options and then click on the "OK" button. 
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B2.20 Adding Drawings 

 

Question 1:  Can I insert text in a drawing such as a rectangle or circle? 

Answer:  Yes. To inset text in a drawing, simply click on it and start typing. When you've 

typed in the desired text, click outside the drawing. 

 

B2.22 Modifying Drawings 

 

Question 1:  How can I maintain the proportions of the drawing while changing its size? 

Answer:  To maintain the proportions of a drawing, press and hold down the "Shift" key 

while dragging the drawing's border to change its size. 

 

Question 2:  What is the function of the green handle that appears on the drawings? 

Answer:  You can drag the green handle to rotate the drawing. 

 

Question 3:  What is the function of the yellow diamond that appears on some of the drawings? 

Answer:  The yellow diamond appears only on 3-dimensional objects such as a cube or a 

cylinder. You can drag the diamond to change the drawing's perspective. 

 

B2.24 Overlapping & Grouping Drawings 

 

Question 1:  If I've grouped a set of drawings, will all of them be deleted if I click on one of 

them and press the "Delete" key? 

Answer:  Yes. If you want to delete only one of the drawings, you must first ungroup them, 

and then delete the desired one. 

 

B2.26 Inserting Tables 

 

Question 1:  How can I delete a table? 

Answer:  To delete the table, first select it by clicking on its outside border, and then press 

the "Delete" key. 

 

B2.28 Inserting Charts 

 

Question 1:  How can I modify the data in an existing chart? 

Answer:  First double-click on the chart. If the chart's datasheet does not open, select 

"Datasheet" from the "View" menu to display the datasheet. Then modify the data 

as desired. 

 

Question 2:  How can I change the color of the bars in a chart? 

Answer:  First, double-click on the chart. Then click on the "Format" tab, click on the 

"Shape Fill" button, and select the desired color for the bar. 
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B2.30 Inserting Movies & Sounds 

 

Question 1:  When I try to play the movie that I inserted in my presentation, I get a message 

indicating that PowerPoint can't play the movie. Why? 

Answer:  The movie is probably in a format that is not supported by PowerPoint. You 

should convert the movie to another format, such as Microsoft Windows Media 

player. 

 

Question 2:  Can I enlarge a movie like a clip art or picture? 

Answer:  Yes. You can enlarge a movie just like a clip art or picture. However, a movie 

plays best at its original size. Therefore, if you enlarge the movie, it may become 

visually distorted. 

 

Question 3:  What is an Animated GIF? 

Answer:  An Animated GIF is a series of images displayed one after another to give the 

appearance of motion like a movie. Many of the movies in the Clip Organizer are 

animated GIF files. An Animated GIF file has the ".gif" extension. 

 

B2.33 Changing Slide layouts 

 

Question 1:  What is the advantage of using a layout to add a combination of elements such as 

text, pictures, tables and charts instead of adding each element to the slide 

individually? 

Answer:  If you use a layout, the elements will be properly sized and arranged in the slide, 

whereas if you add the elements individually, you will have to resize and arrange 

the elements yourself.  

 

B2.35 Slide Master 

 

Question 1:  Can I use the slide master to change the bullet style of all the bulleted lists in a 

presentation at once? 

Answer:  Yes. Simply click on the desired bulleted line corresponding to the bulleted lists 

in the presentation. Then change the bullet style of the line as desired. The new 

bullet style will be applied to all the bulleted lists in the presentation. 

 

B2.37 Themes 

 

Question 1:  Can I delete a theme from the "Themes" gallery? 

Answer:  You can only delete a customized theme that you saved as follows: 

 

1) Click on the "Design" tab. 

2) Click on the Themes gallery's "More" button. 

3) In the "Custom" area, right-click on the theme that you want to delete. 

4) Select "Delete" from the menu. 
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B2.39 Templates 

 

Question 1:  Can I create a new template based on the existing format settings in my 

presentation? 

Answer:  Yes. You can save your presentation's format settings as a new template as 

described in the lesson. However, please note that only the format settings in the 

Slide Master will be saved in the template. The format settings that have been 

applied to individual slides will not be included. 

 

B2.41 Slide Transitions 

 

Question 1:  How can I remove a transition from a slide? 

Answer:  First select the slide and then click on the "Animations" tab. Then click on the 

"Slide Transition" gallery's "More" button and click on "No Transition." The 

transition will be removed from the slide. 

 

B2.42 Unit 2 End 

 

Question 1:  Can I review the sections I've already visited? 

Answer:  Yes. You can either use the "Previous" section button or the "Table of Contents" 

to go to the desired section. 


